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Typographical Conventions 

Before you start using this guide, it is important to understand the documentation 
conventions used in it.  

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information Example 

Special Bold Items you must select, 
such as menu options, 
command buttons, or 
items in a list. 

Go to the System tab. 

 Titles of chapters, 
sections, and subsections. 

Read the Basic Administration 
chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to 
designate a command line 
placeholder, which is to be 
replaced with a real name 
or value. 

The system supports the so 
called wildcard character search. 

Monospace The names of commands, 
files, and directories. 

The license file is located in the 
http://docs/common/licen

ses directory. 
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Formatting convention Type of Information Example 

Preformatted On-screen computer 
output in your command-
line sessions; source code 
in XML, C++, or other 
programming languages. 

# ls –al /files 

total 14470 

Preformatted Bold What you type, contrasted 
with on-screen computer 
output. 

# cd /root/rpms/php 

CAPITALS Names of keys on the 
keyboard. 

SHIFT, CTRL, ALT 

KEY+KEY Key combinations for 
which the user must press 
and hold down one key 
and then press another. 

CTRL+P, ALT+F4 

 
 

Feedback 

If you have found an error in this guide, or if you have suggestions or ideas on how to 
improve this guide, please send your feedback using the online form at 
http://www.parallels.com/en/support/usersdoc/. Please include in your report the guide's title, 
chapter and section titles, and the fragment of text in which you have found an error. 

 

http://www.parallels.com/en/support/usersdoc/


 

  
 

Parallels Plesk SiteBuilder is an easy and intuitive means of creating websites for small 
businesses and individuals. 

To start creating a website with SiteBuilder, you first need to select your website topic, 
specify website name, and select a language. Please note that the language is 
selected for your website, not for SiteBuilder interface. SiteBuilder interface language 
can be changed only through Parallels Plesk Panel. 

You will be prompted to provide information about yourself to prefill your website with 
information. Please note that the information you provide will not be stored or used 
anywhere else, it will be used only for filling your website content, such as “About Us” 
and “Contact Us” pages. You can change or remove this information at any time later. 
When the necessary information is provided, SiteBuilder generates a website with the 
unique design. SiteBuilder website design consists of a number of elements. Each time 
SiteBuilder generates a website design, a random set of elements designs is used, so 
you can be sure that the website design you receive is never repeated. 

 

C H A P T E R  1  

Introduction 



 

  
 

SiteBuilder interface consists of two major parts: your website and main menu. 

SiteBuilder website consists of a number of elements, or modules. Each module can be 
edited separately. Here we will familiarize you with basic principles of website modules 
editing similar for all modules. 

SiteBuilder website modules can be of two basic types:  

 Simple modules – these modules appear only on one website page, such as a 
simple text block. 

 Sitewide modules – these modules appear on all website pages, such as the 
website header or navigation. 

To locate a website module, hover the mouse pointer over the part of the website you 
want to change. A dotted frame will appear around the module. A control panel 
prompting to move, edit, or remove/hide the module will appear next to the dotted 
frame. 

The dotted frame around simple modules is dark grey, around sitewide modules it is 
purple. 

To edit a website module, click anywhere on the module. A dotted frame will appear 
around the module. A context menu with module editing options will appear next to the 
dotted frame. 

SiteBuilder main menu offers website editing options grouped in five tabs: 

 Modules. Here you can choose necessary modules and drag them to any place on 
the page to fill your website with content. 

 Layout. Here you can select the number of sidebars on the page, width of the page, 
sidebars and margins, and fixed or liquid type of layout. 

 Style. Here you can select base color scheme for your website, change colors of 
separate elements, select fonts and styles of borders for your website. 

 Pages. Here you can add and delete pages, rename them, edit such page meta 
information as description and keywords, mark page as hidden, so that your visitors 
cannot access it from the site menu. 

 Settings. Here you can edit your website name, description and keywords for search 
engines, upload a site icon (favicon), optimize ranking of your website in search 
engine results. 

From the main menu, you can also do the following: 

 Access SiteBuilder Getting Started video tutorial and User’s Guide. To do this, select the 
corresponding option from the Help menu. 
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 Save and load copies of your website by using the Save and Revert options. 

 Publish your website by using the Publish button. 

 Discard any changes made to a site and start creating a site anew by selecting 
More > Start Over. This does not delete your already published site copy. 

 Delete a website from a hosting account by selecting More > Remove Site. 

You can drag the main menu to any place on the page for your convenience or 
minimize it. 

You can also access all options of the main menu in the context menu at any place on 
the page. To open the context menu, click the right mouse button. 

 



 

  
 

 To create a website in SiteBuilder: 

1. In Control Panel, go to either the Home tab or the Websites & Domains tab, 
and click Launch SiteBuilder. 

If you have only one domain name configured, SiteBuilder will open in a new 
browser window or tab. 

2. If you have several domain names, click the corresponding link Edit in 
SiteBuilder. The SiteBuilder wizard will open in a new browser window or 
tab. 

3. Select your website topic and click Create Site. 

4. Provide information about yourself to prefill your website. 

Note: The information you provide will not be stored or used anywhere else, it will 
be used only for prefilling your website content, such as “About Us” and “Contact 
Us” pages. You can change or remove this information at any time later.  

5. Click Submit and create site. 

SiteBuilder takes some time to generate a website with unique design and prefilled 
content. 
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In SiteBuilder you can change virtually each element of your website. Simple elements 
are changed in place - you open a page where the element is used, edit it and see the 
result right away. Sitewide elements are changed in one place but the changes are 
applied to each page of your website. 

Note: If you are using Internet Explorer, we strongly recommend that you avoid using 
browser zoom to change the size of text displayed in your browser window. Please 
note that SiteBuilder websites will perform and look best at normal zoom (100%). 

In this chapter: 

Working With SiteBuilder Modules .................................................................... 10 
Sitewide Editing Options ................................................................................... 12 
In-place Editing Options .................................................................................... 21 
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Working With SiteBuilder Modules 

Your website content consists of elements, or modules. You can add new modules to 
your website, edit them or delete them. 

SiteBuilder website modules can be of two basic types:  

 Simple modules – these modules appear only on one website page, such as a 
simple text block or a script. 

 Sitewide modules – these modules appear on all website pages, such as the 
website header or navigation. 

There are the following modules in SiteBuilder: 

 Text & Images. Add text, hyperlinks and images to any page of your website. 

 Embedded Video. Embed video clips located on popular video sharing sites, such as 
YouTube. To embed a video clip using this module, you can use a link to the video 
or a custom code provided by a file sharing site. 

 Navigation. Insert a navigation block into all website pages. 

 Sitewide Text & Images. Add text, hyperlinks, and images to all website pages. 

 Header. Add a header image to your website. It will be applied to all website pages. 

 Script. Add a script to any page of your website. You can use HTML or PHP code in 
this module. HTML code can contain client-side scripts such as JavaScript or 

VBScript. For PHP, use the opening tag <?php. Make sure the code you insert in 

this module is correct, as SiteBuilder does not validate it. Your code will be active 
only on the published website. 

 Advertisement. Add an advertisement block to all website pages. In this module, you 
can use HTML code containing client-side scripts such as JavaScript or VBScript 
provided by your advertising vendor. Make sure the code you insert in this module 
is correct, as SiteBuilder does not validate it. With some advertising vendors, you 
will need to validate your account first. Advertisements will appear on your website 
after publishing. 

 Search. Add an ability for your website visitors to search for information on your 
website. The search bar will be added to all site pages. If you use Google search 
engine, a predefined search code is used. For other search engines, you can use 
HTML code containing client-side scripts such as JavaScript or VBScript provided 
by the selected search engine. Make sure the code you insert in this module is 
correct, as SiteBuilder does not validate it. The search bar will appear on your site 
after publishing. 

 Contact Form. Add an ability for your website visitors to send you their comments or 
requests. 

 Breadcrumbs. Add breadcrumb navigation blocks to all pages of your website. 
Breadcrumb navigation is a chain of links that represents the user's path from the 
site's main page to a current page. 

 Social Sharing. Insert a toolbar with buttons that let your visitors easily share your 
content on social networks or online bookmarking services. The toolbar includes 
buttons for sharing on Facebook, Twitter, Myspace, and other popular services. 
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 To add a module to your website page: 

1. Go to the Modules tab of SiteBuilder main menu. 

2. Click the required module and drag it to the desired place on the 
website page. 

Alternatively, at the desired place on the website page click the right mouse button > 
Add > select the module to add. 

 To change module settings: 

1. Hover the mouse pointer over the part of the website you want to 
change. A dotted frame will appear around the module. 

2. Click anywhere on the module. A context menu with module editing 
options will appear next to the dotted frame. 

 To remove a website module: 

1. Hover the mouse pointer over the part of the website you want to 
remove. A dotted frame will appear around the module. A control panel 
prompting to move, edit, or remove/hide the module will appear next to 
the dotted frame. 

2. Click Remove and confirm removal. 
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Sitewide Editing Options 

To edit your website layout, go to the Layout tab of the main menu. Here you can: 

 Select the number of sidebars on the page (no, one or two sidebars). 

 Select the layout type (fixed or liquid). 

 Select the size of page elements, such as page, sidebars and margins width and 
page minimal height. 

To edit your website color schemes and fonts, go to the Style tab of the main menu. 
Here you can: 

 Select general color scheme composed of four colors for your website on the 
Scheme subtab. You can also edit each of the four colors here. 

 Select color for certain website elements and fonts on the Colors subtab. Modifying 
the styleset on the Scheme tab will override changes made here. 

 Select fonts for headings and body text on the Fonts subtab. 

 Select styles for your website borders on the Borders subtab. 

To edit your website structure, go to the Pages tab of the main menu. Here you can: 

 Add and delete pages. 

 Rename pages and edit such page meta information as description and keywords. 

 Mark page as hidden, so that your visitors cannot access it. 

To edit your website general settings, go to the Settings tab of the main menu. Here you 
can: 

 Edit the website name, description and keywords on the Basic subtab. 

 Upload a site icon (favicon) for your website on the Basic subtab. 

 Make your website more visible in search results and embed various search engine 
services on the Advanced subtab. 

 

In this section: 

Editing Your Website Layout ............................................................................. 13 
Editing Your Website Colors and Fonts ............................................................. 14 
Editing Your Website Structure ......................................................................... 16 
Editing General Settings of Your Website .......................................................... 18 
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Editing Your Website Layout 

A website created with SiteBuilder can have one, two, or no sidebars. On a sidebar, 
you can place a navigation block, an ads block, or just a sitewide text or image.  

 To select the number of sidebars on your website: 

1. Go to the Layout tab of the main SiteBuilder menu. 

2. Select No sidebars, 1 sidebar, or 2 sidebars. 

3. To move a sidebar to another side of your website with one sidebar, or 
to switch sidebars on your website with two sidebars, click Switch 
sidebars. 

4. Click OK to save changes. 

 To select the layout type for your website: 

1. Go to the Layout tab of the main SiteBuilder menu. 

2. Select the layout type and specify the website width: 

 Fixed layout: your website will be of specific size regardless of the size of the 
browser window viewing the page. In this case, specify your website width in 
pixels. 

 Liquid layout: based on percentages of the current browser window's size. In this 
case, specify your website width as a percentage of the browser window's size. 

3. Click OK to save changes. 

 To select the the size of page elements on your website: 

1. Go to the Layout tab of the main SiteBuilder menu. 

2. Specify the size of vertical and horizontal margins, which is the space 
between the neighbouring elements edges, in pixels. 

3. For a website with one or two sidebars, select Sidebar width and specify 
the width of each sidebar in pixels. 

The size of the main content field will be determined automatically. 

4. Select Minimal height and specify the height of each sidebar and the main 
content field in pixels. 

This value shows the height of your website elements without content. When you 
add content to the sidebars and the main content field, they will stretch in height to 
fit the content. 

5. Click OK to save changes. 
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Editing Your Website Colors and Fonts 

General color scheme, or styleset, of your website is comprised from four colors. Each 
color is used for several website elements at once. You can adjust colors of individual 
elements on the Colors tab. 

 To select general color scheme for your website: 

1. Go to the Style tab of the main SiteBuilder menu, then go to the Scheme 
subtab. 

2. Select the color scheme, or styleset, of your website in the drop-down 
menu. 

You will see the four colors composing the color scheme of your website. 

3. To adjust a color of your website color scheme, click the respective 
color field and edit the hex value or select a color with the color picker.  

Note: The changes of individual elements colors previously made on the Colors 
subtab will be overridden by the changes made here. 

4. Click OK to save changes. 

 To select colors of individual website elements: 

1. Go to the Style tab of the main SiteBuilder menu, then go to the Colors 
subtab. 

2. Select the element in the drop-down menu. 

3. Adjust the element background color by clicking the background color 
field and editing the hex value or selecting color with the color picker.  

4. Select the element gradient from the drop-down menu.  

5. For element with text, adjust font colors by clicking the respective color 
field and editing the hex value or selecting a color with the color picker.  

Note: To revert changes of colors made here, select the Auto checkbox next to the 
color value field. 

Note: Modifying the styleset on the Scheme tab will override changes made here. 

6. Click OK to save changes. 

 To select fonts for headings and body text of your website: 

1. Go to the Style tab of the main SiteBuilder menu, then go to the Fonts 
subtab. 

2. For each font, select the font-family and font size in the drop-down 
menus. 
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3. For headings, select the font decoration. This can be B for bold and I for 
italics.  

Note: The settings made here define only general rules for your website fonts. You 
can always adjust fonts of individual elements in place. 

4. Click OK to save changes. 

 To select borders for website elements: 

1. Go to the Style tab of the main SiteBuilder menu, then go to the Borders 
subtab. 

2. Select the border type for elements inside your website from the Internal 
containers border drop-down menu. 

3. Select the elements that will have the border. 

Note: You can select only one internal border type for all elements on your website, 

but you can select whether this border will be used for certain elements. 

4. Select the external border for your website from the External site border 
drop-down menu.  

5. Click OK to save changes. 
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Editing Your Website Structure 

In SiteBuilder, there are two levels of pages nesting. 

 To add a new page to your website: 

1. Go to the Pages tab of the main SiteBuilder menu. 

2. Click Add page. The new page appears highlighted with green. 

3. Position the new page by dragging it to the right place or by using 
arrows. 

4. Specify the page title. 

5. Specify a concise description of the page content that will be displayed 
on search engines results pages and the keywords by which the page 
will be found by search engines. 

Note: Page name and Page link name are required fields. Description and Keywords are 
optional fields. If you specify keywords for a page, they should be separated by 
commas without white spaces. 

6. If you want to make the page invisible for your website visitors, select 
the Hidden page checkbox. 

7. If you want to restrict access to the page with password authentication, 
select the Protected page checkbox and specify a username and a 
password. 

8. Click OK to save changes. 

 To delete a page from your website: 

1. Go to the Pages tab of the main SiteBuilder menu. 

2. Select the page you want to delete. 

3. Click Delete page. 

4. Click OK to save changes. 

 To edit a page of your website: 

1. Go to the Pages tab of the main SiteBuilder menu. 

2. Select the page you want to edit. 

3. Change the page position by dragging it to the right place or by using 
arrows. 

4. Edit the page title. 
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5. Edit or remove a concise description of the page content that will be 
displayed on search engines results pages and the keywords by which 
the page will be found by search engines. 

Note: Page name and Page link name are required fields. Description and Keywords are 
optional fields. If you specify keywords for a page, they should be separated by 
commas without white spaces. 

6. If you want to make the page invisible for your website visitors, select 
the Hidden page checkbox. 

7. If you want to restrict access to the page with password authentication, 
select the Protected page checkbox and specify a username and a 
password. 

8. Click OK to save changes. 
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Editing General Settings of Your Website 

 To edit your website name, description, and keywords: 

1. Go to the Settings tab of the main SiteBuilder menu, then go to the Basic 
subtab. 

2. Specify your website name that your visitors will see as the title of their 
browser window when they visit your website. 

3. To show both your website name and current page name in the browser 
title window and to increase your website recognition in search engine 
results, select the Add website name to page titles check box. 

4. Add short description (up to 255 symbols) of your website. 

This description will be used as a default description for new pages. It will be shown 
by search engines when people see your website in search results. 

5. Provide a list of keywords that describe your website (10-15 keywords 
are recommended). 

These keywords will be used as default keywords for new pages. Keywords are 
analyzed by search engines and used for displaying your website when people 
search for these keywords. 

6. Click OK to save changes. 

Favicon is a small icon displayed in the browser’s address bar when you visit a 
website, and next to the website name in the list of favorite bookmarks. You can create 
a favicon using a variety of online tools and then upload your favicon here. All your 
website visitors will see this favicon. 

 To upload a favicon for your website: 

1. Go to the Settings tab of the main SiteBuilder menu, then go to the Basic 
subtab. 

2. Click Browse and select the location of the favicon to upload. The 
favicon will be uploaded. 

3. Click OK to save changes. 

 To remove a favicon from your website: 

1. Go to the Settings tab of the main SiteBuilder menu, then go to the Basic 
subtab. 

2. Click Remove in the Favicon section. The favicon will be removed. 

3. Click OK to save changes. 
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Most search engines require you to verify website ownership when you register your 
website or sign up for webmaster assistance services. Verification is typically done by 
uploading or creating a file with specific file name. 

 To verify website ownership: 

1. Go to the Settings tab of the main SiteBuilder menu, then go to the 
Advanced subtab. 

2. Provide the verification file: 

 If you know the name of verification file requested by a search engine, provide 
the verification file name in the Create verification file field and click OK. SiteBuilder 
will create it in the correct place.  

 If you have already downloaded your verification file from a search engine, 
upload the verification file to the Upload verification file field and click OK.  

3. After the verification file is created or uploaded and your website is 
published, confirm your ownership on the search engine website.  

4. Click OK to save changes. 

 To edit the HTML <head> section of your website (for example, to add 

ownership verification meta code): 

1. Go to the Settings tab of the main SiteBuilder menu, then go to the 
Advanced subtab. 

2. Click Edit Metadata. 

3. Insert the code into the provided field and click Add.  

Note: Only valid HTML tags permitted for <head> section by HTML standards are 

supported. 

Note: Metadata changes will be available only after you publish your website. 

4. Click OK to save changes. 

Google Analytics is a tool that allows you to learn more information about your visitors. 
After you register in Google Analytics and acquire the required code, you can embed 
Google Analytics on your website. 

 To embed Google Analytics: 

1. Register in Google Analytics and acquire the code. 

2. Go to the Settings tab of the main SiteBuilder menu, then go to the 
Advanced subtab. 

3. Click Embed Google Analytics. 

4. Insert the code you have received from Google Analytics to the 
provided field and click Add.  
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Note: Google Analytics will start working only after you publish your website. 

5. Click OK to save changes. 

Some search engines will ask you to provide your sitemap for analysis and optimization 
purposes. You can download your sitemap here.  

 To download your website sitemap: 

1. Go to the Settings tab of the main SiteBuilder menu, then go to the 
Advanced subtab. 

2. Click Download Sitemap. 

3. Click OK to start downloading the sitemap.xml file. 
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In-place Editing Options 

Each SiteBuilder website element can be edited in-place, moved to another place on 
the page, or removed/hidden. 

 To edit a website element in-place: 

1. Click the part of your website page you want to edit. 

The website element will go to the editing mode. A dotted frame will appear around 
the module. A control panel with editing options will appear next to the module. 

2. Edit the website element to your needs. 

3. To save changes, click OK in the editing control panel or just click 
anywhere on the page outside the edited element. 

 To move a website element to another place on the page: 

1. Hover the mouse pointer over the part of the website you want to move. 

A dotted frame will appear around the module. A control panel prompting to move, 
edit, or remove/hide the module will appear next to the dotted frame. 

2. Click the crossed arrows symbol and drag the module to the desired 
place. 

 To remove a website element: 

1. Hover the mouse pointer over the part of the website you want to 
remove. 

A dotted frame will appear around the module. A control panel prompting to move, 
edit, or remove the module will appear next to the dotted frame. 

2. Click Remove and confirm removal. 

Such elements on your website header as the logo image, your website title and 
subtitle cannot be removed, they can only be hidden. 

 To hide a website logo image, title or subtitle: 

1. Hover the mouse pointer over the element you want to hide. 

A dotted frame will appear around the module. A control panel prompting to move, 
edit, or hide the element will appear next to the dotted frame. 

2. Click Hide. 

 To show hidden website logo image, title or subtitle: 

1. Hover the mouse pointer over the website header element. 
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A dotted frame will appear around the module. A control panel prompting to move, 
edit, or hide the element will appear next to the dotted frame. 

2. Click Edit. 

3. In the Show Header Elements section, select the desired elements. 

 

 



 

  
 

While working on the content and design of a website, you can save several copies of 
each site to the server and restore sites from the saved copies. Saving site copies can 
be useful in the following cases: 

 You want to prepare several versions of the same website, so that you could later 
load them for review, choose the best designed or the most appropriate version, 
and publish it to the Internet. 

 You want to make significant changes or experiment on the site design or content, 
and be sure that you can safely undo the changes, should anything go wrong. 

 To save the current design and content of a site: 

1. In the SiteBuilder's main menu, click the black triangle next to the Save 
option. 

Note: If you click Save, a quick-save site copy will be saved under the name auto-
saved snapshot. You will be able to restore a site from this copy later, by clicking 
Revert in the main menu. 

2. In the list that opens, select a free saving slot, type a name for the 
backup copy, and click Save. 

 To restore a site from a saved copy: 

1. In the SiteBuilder's main menu, click the black triangle next to the Revert 
option. 

Note: If you click Revert, a site will be restored from the quick-save copy that was 
made the last time when you clicked Save. 

2. In the list that opens, select a site copy and click Load. 

3. Click Yes to confirm restoring. 
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When your website design and content are ready to be published to the Internet, click 
Publish in the top right corner of the main menu. SiteBuilder will publish your website 
automatically to the location specified by your hosting provider. 
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 To delete an already published website from your hosting account: 

In SiteBuilder's main menu, select More > Remove Site. 

This will delete the site from your hosting account, delete any temporary site copy 
currently opened in SiteBuilder editor and all saved site copies. 
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